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Introduction

Flexman is the AVEVA wrapping around the FLEXnet licensing system, previously called
FLEXIm. AVEVA product releases from the end of 2008 require Flexman 4 so any existing
Flexman 3 License Service must be upgraded. After upgrading to Flexman 4.1, AVEVA
software that has been running with a Flexman 3.1 license service will still run:

Flexman 3.1 or
Flexman 3.1 SP1

| FLEXIm 3
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before starting Flexman 4.1
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Upgrading from Flexman 3.1 or Flexman 3.1 SP1

Flexman 4.1 installs in a different folder from Flexman 3.1:
C:\Program Files\cadcentre\Flexman 3.1
C:\aveva\Flexman4.1

Flexman 3.1 by default installed in:
Flexman 4.1 installs into the folder:

The steps are described in detail in License Service Installation & Administration, but in
brief:
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¢ Install Flexman 4.1 while Flexman 3.1 is still running

« Copy the current license file into the Flexman 4.1 folder

« Create a new License Service with a new name

e Stop the Flexman 3.1 License Service

« Start the Flexman 4.1 License service

* Remove the Flexman 3.1 License Service and then un-install Flexman 3.1

Installing a Network License Service

Most companies set up a system of network or floating licenses that are shared by all users
on the same network. A single license file then defines the available entitlement for all users
running AVEVA products concurrently on that network.

A machine running Windows Server 2003 is most commonly used for the centralised
License Service but any PC on the network running Windows XP or Vista can be used. The
machine with the license file is known as the License Server and runs the License
Service. The license file is anchored to a hardware ID on the License Server so that it will
only work on that machine. AVEVA needs the details of the hardware ID to be sent before a
license file can be issued.

Installation of Flexman involves two stages:

1. The Customer's License Administrator sets-up the FLEXnet License Service with the
License File on the designated License Server machine. (Laptop users must do this for
themselves. Refer to Installing a License Service on Laptop).

2. The machines on which AVEVA products are running must then be configured so that
they can find the License Service to request a license (see Configuring a PC to Run
AVEVA Products).

Note: The version of the FLEXnet licensing toolkit we are using is not supported on
Windows Server 2008

Special Circumstances

Installation can be more complex in certain situations and the following are covered in
Special Situations:

« Installing a License Service on a laptop.

e Windows VISTA.

« Machines that are locked-down so that users have restricted access rights.
* Another product such as AutoCAD that also uses FLEXnet is already in use.
* Running AVEVA products via Citrix, Remote Desktop or Terminal Services

« Setting access to a License Service from within a DOS batch file.

Further Information and Guidance
Further information and guidance about licensing is available from the AVEVA website,
Wwww.aveva.com.

Click the Product Support tab and select the Licensing section for information on:
« Where to request a new or updated license file
« How to get help with setting up a license service
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* News of Flexman updates and new version downloads
* Dongle Driver download
* Advice about recently encountered licensing issues and workarounds.
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License Service Installation & Administration

Flexman 4.1 Installer

The Flexman 4.1 installer is included on all AVEVA major product media and can also be
downloaded from the Licensing section on the Product Support tab at the AVEVA
website:

www.aveva.com

When the Flexman 4.1 installer is run three options are offered:

Install Option Components Installed Description
Server Install Imgrd.exe 11.5 The License Manager Daemon from
Acresso Software
Imtools 11.5 License service set-up utility from
Acresso Software
cadcentre.exe 4.1 The Vendor Daemon from AVEVA
Solutions
FlexmanConfig 4.1 AVEVA's utility for configuring a PC and
diagnosing Licensing problems
Client Install FlexmanConfig 4.1 AVEVA's utility for configuring a PC and

diagnosing Licensing problems

Documentation Flexman 4.1 Installation This document from AVEVA
and Configuration Guide

License Administrators FLEXnet documentation from Acresso
Guide 11.5 Software

The user needs Server install to set up a license service - this will be a server machine on
the network, a laptop or a free-standing desktop computer.

The Client install provides the FlexmanConfig tool for configuring the connection to the
License Server and is needed wherever an AVEVA product is being installed.

How to Obtain a License from AVEVA

Note: If Flexman 3.1 or Flexman 3.1 SP1 is already installed, simply copy the existing
license file from the Flexman 3.1 folder into the Flexman 4.1 folder.

The License Administrator is recommended to use the FlexmanConfig utility and click on
the Analyse and report settings button:
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~Help

How do I refer to my License Server? | Which setting should I use? I I 2 Analyse and report settings I

—Vendor spedfic server settings (CADCENTRE_LICENSE_FILE] - other vendors may not use all the settings below 7|

Which settings you should use

As an administrator, you may be setting up the system on behalf of one or more user accounts, or maybe just your own.
If you are setting it up for other users, then you should NOT use either of the two User Environment variables.
If you want the user to OVERRIDE the settings that you =set for all users, then set the System Environment variable,
this is so that the user {who may not have administration privileges) can hide the System Environment variable
with their own User Environment variable.
If you want the user to be able to ADD servers to the list of servers then use the System Registry entry as this is not
1 hidden by a User Environment variable. Also use the System Registry entry when setting up the system for your own use.

Should you use the "vendor™ versions or the “shared” versions?

If there are other vendors' license features served by the spedified servers, then you can set the "shared” settings.
AVEVA recommends using the “vendor” specific settings for each vendor as they do not affect other vendor's products.
"Vendor” settings are always tried before the "shared” LM settings, they do not hide the "shared” settings.

To summarise, use the "vendor” specific System Registry entry (the third edit box) unless you want to override a System
| Environment variable that you do not want to remove.

Cancel

~Help

How do I refer to my License Server? Which setting should I use? Analyse and report settings |

M Flexman configuratio

User Name Identifier: "USER =alan.jenyon'

Display Name Identifier: 'DISPLAY=UKCAMD 1654]

Host Name Identifier: 'HOSTNAME=UKCAMD 1654

Disk Yolume Identifier: 'DISK_SERIAL_NUM=e8b10835'

Internet (IP) Address Identifier: 'TNTERMET=10.0.99,12'

TRIBOM_DONGLE Identifier: TRIBON_DOMGLE=DRIVER_NOT_IMSTALLED'

AVEVA_X Identifier: 'AVEVA_X=ED300F596C99C976'

Composite Identifier: 'COMPOSITE=6F7ESTBB3771'

Ethernet {MAC) Address Identifier: '00110AA387D4 for Broadcom MNetXtreme Gigabit Ethernet - Packet Scheduler Miniport
Hardware Identifiers : 'AFWDC WDS00BB-00FJAQ-WD-WMAI96413514

A Network adapter (0011044 387D4) has been identified, it should be used as the MAC address (License HostId)
to send to AVEVA when requesting a license for this machine. DO NOT DISABLE THIS ADAPTER.

Analysis of currently configured servers for administrator alan.jenyon on UKCAMD 1654...
Currently you have not set any license servers for AVEVA applications to use.

Unda & Jes | SavE ar | Cancel |

Copy the highlighted text and send it in an e-mail with your request for a license.
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Where there are two or more Ethernet adaptors on a PC, decide which Ethernet address
should be used for the license file and inform AVEVA. This must be for a network adaptor
that will never be disabled.

Note: The utility Imtools is used to obtain the required HostID information but does not
handle the situation of two or more Ethernet addresses, and is not recommended.
Another possibility is to use the DOS command IPCONFIG -ALL

Given the hostname and Ethernet address, the AVEVA License Administrator will send a
license file specific to this machine.
* AVEVA products can not be used until a license service is started using this license file.
e The license file will not work on any other machine.

Installing the License File

AVEVA recommends the following approach for installing the license file:
e Copy the license into the Flexman 4.1 folder.

« Edit the Port Numbers on the SERVER and VENDOR lines if required.
(Refer to Editing the License File Header and Firewalls and Port Numbers).

« Rename the new licence file to license.lic. Using this name makes it easier to update
the license file in the future.

Editing the License File Header

To avoid issues with firewalls, AVEVA recommends the specifying of a Port Number for the
Vendor Daemon as well as for the License Server. (Refer to Firewalls and Port Numbers).

Edit the license file to add a Port Number to the VENDOR line in the license file, as shown
below. The default Port Number on the SERVER line can also be changed if necessary to
comply with local policy on the use of Ports on the server machine.

# BPM LG July 2007

Customer Code ..oovveeenneen. [UKCAMD1654]
Customer Location Number .... [1]

Issued ON ovveevveeee, [18-Aug-2008] [14:41]

All lines beginning with a # character are comments and can be removed.
This is a COMPLETE license file for this location

Please replace the previous license.lic with this file
and after renaming this file license.lic

#Server(s)

SERVER UKCAMD1654 00110aa387d4 744 — Port Number can be changed
#VENDOR Name

VENDOR cadcentre PORT=7153 ———— DPort Number can be added

Note: NOTEPAD must be used, for the edit Using Word or Wordpad for the edit can
introduce additional but unseen changes in the license file.

2:3



'AV=VA Flexman 4.1 Installation and Configuration Guide

License Service Installation & Administration

« Other changes to the license file are not normally required and the License Service will
reject any INCREMENT lines that have been changed.

« Check when finished that there is only one license file present in the folder and that it is
called license.lic - especially if the file has been edited in-situ.

« Move any license file not being used into a sub-folder called Old License Files.

2.5 Creating a License Service as a Windows Service

Invoke the Imtools.exe utility:

LMTOOLS by Macrovision Corporation http://www.macrovision.com
File Edit Mode Help

Service/License File §5ystem Settings] Utililies] Start/Stop/Rersad | Server Status | Server Diags | Config Servicesl Eorrowing]

Services allow FLEXnet Servers to mn in the background.
Server List

™ Configuration using License File

I * Configuration using Services I

AWEWA Flexmar 3.1 Name(s) of
existing License
Services, if any

I v LMTOOLS ignores license file path enviranment variables I

* Onthe Service/License File tab make sure that Configuration using Services option
is selected.

* Always tick LMTOOLS ignores license file path environment variables when
LMTOOLS is being used to configure a License Service.

Note: These screenshots are based on LMTOOLS 11.5 running on Windows XP SP2.
Other versions may have a different appearance.

Important: Take Care When Upgrading From Flexman 3.1.
In the next step type in a new name so that a new License Service is created.
Failure to do this will cause the existing License Service to be redefined. This
will work but means that you will be unable to revert quickly back to the
Flexman 3.1 License Service if you need to resolve any issues with the new
Service.

Select the Config Services tab: There are 4 fields and 2 tick boxes to complete:
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. by Macrovision Corporation http://www.macrovision.com !‘E@
ServicedLicenss File | System Settings | Utililies] Start/Stop/Reread | Server Status | Server Diags| Config Services §Bonawing |

Configure Service You must type in a new name M
Servics Name IA\IEVA Flexman 4.1 _.'_1 M
emaove Service

Path ta the Imgrd.exe file 2 IC: WAWENANFlext and. T mard. exe dinupe

Browse
Fath to the licensze file 3 I

Path to the debug log file 4 | Browse I Wiew Log...l Close Log I

Look in: ].:) FlexMand. 1 _'.J g |‘=:F B~

.‘: ||ﬂ license. lic

] My Recent
Documents

Service Name [1]

Type in a new name for a License Service that will be meaningful among the list of other
Windows Services later on, such as AVEVA Flexman 4.1 .

Note: Take special care at this point if a License Service, such as Flexman 3.1, already
exists. You MUST type in a new name at this point to avoid making changes to an
existing License Service.

Path to the Imgrd.exe file [2]

Select the Browse button and navigate to the Flexman 4.1 folder. Select the Imrgd.exe file
and click Open to confirm.

Note: It is possible to share the Imgrd.exe used for a product from another supplier.
However, AVEVA recommends using a separate Imgrd.exe for each Vendor
Daemon to avoid version incompatibilities.

Path to license file [3]

Repeat for the path to the license file using the Browse button.

Path to the debug log file [4]

Select the Browse button and in the pop-up dialog box make sure you are in the Flexman
4.1 folder. Type debug.log in the Filename field and click Open to confirm.

Note: The debug.log file does not need to exist yet - the License Service will automatically
create a log file with the name previously given when the License Service is started.
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LMTOOLS by Macrovision Corporation hittp://www.macrovision.com
File Edit Mode Help

Service/License Filel Sustemn Settings] Utilities] Start/Stop/Reread | Server Status | Server Diags Bonowing]

Configure Service
Save Service
Service Mame BV Flewrman 4. -
Remowe Service

3
Path ta the Imgrd.sxe file |C: WAWEWANFlextand. T\ mard. exe M

Fath ta the license file |C: WAWEWANFlert and. 1 icense lic Sl

Path to the debug log file | & AVEVANFlexh and. 1hdebug. log Browse | Wigw LDQ---|

2 ||7 Start Server at Power Up I 1 I v Use Services I

Tick the Use Services box [1] and then Start Server at Power Up box [2]. Click the Save
Service button [3] and confirm Yes when prompted

Stopping an Existing Flexman 3.1 License Service

This section explains what to do next if upgrading an existing Flexman 3.1 License Server.
Skip this section if installing Flexman for the first time.

Before leaving the Config Services tab, select the name of the License Service that is
currently running and that is now to be stopped.
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LMTOOLS by Macrovision Corporation http://www.macrovision.com

File Edit Mode Help

SemvicesLicenze File] Suztem Settings] Utilies| Stat/Stop/Reread §5erver Status | Server Diags | Config Services] Bnlrnwingl

FLE*net icenze services installed on this computer

Start Servar Ootion
2 Fiestrict Imdown to work only AWEWS Flexman 3.1 Ensure that the
¥ from node where Imagrd is .
) name of the License
Dizable Imdown utility, use SEI’VIFE YOU. wish to
task manager. stop is highlighted

r Dizable Imremove’ of icense
file.

Start Sepver ‘ 3 Stop Server FeRead Licenze File

| Force Server Shutdown

L |
T SRR MOTE: This box must be checked to shut down a license server

when licenses are borowed.

NEVER tick this box!

|Using License File: C:AAWEWANFlextd and. Thlicensze lic

Select the Start/Stop/Reread tab.
Click the Advanced Settings button [1].
Tick Restrict Imdown to work only from node where Imgrd is running [2].

This makes sure that you cannot inadvertently shut-down another license service on the
network.

Note: If logged into a different machine and need to shut down the license service, leave
this box un-ticked.

Click the Stop Server button [3] to stop license service immediately.

Note: NEVER tick Force Server Shutdown - it can result in other License Services on the
network being shut down unintentionally. AVEVA products do not currently support
'‘Borrowed' licenses so there will never be any need to use this option.

Do not rush to start the new License Service - allow sufficient time for the service that
has just stopped to release the ports it was using.

If the existing License Service was modified, rather than naming a new License
Service, apply the changes, stop and then start the existing License Service.
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Starting the Flexman 4.1 License Service

Check the correct service name is displayed and select Start/Stop/Reread.

LMTOOLS by Macrovision Corporation hittp://www.macrovision.com

File Edit Mode Help

Service/License Filel Syztem Settings] Utiities| Start/Stop/Reread §Server Status | Server Diags | Config Sewices] Bonowing]

FLE®ret licenze services inztalled on this computer
Start Server Options

2 Fiestrict Imdovan to work, only
v from node where mgrd is | &WE WA Flesman 4.1 | Ensure that the name of
LT} the License Service you

Diizable Imdown utility, uze
tazk manager.

wish to start is highlighted

r Dizable ‘mremove’ of license
filee.

Start Server Stop Server FReRead Licenze File

(%]

I Force Server Shutdown
1 | advanced zettings <<

MOTE: This box must be checked to shut down a licensze server
when licenses are borrowed.

|Using Licenze File: CAAVEW AN e and Thlicenze lic

Click the Advanced Settings button [1].

Tick Restrict Imdown to work only from node where Imgrd is running [2]. This makes
sure that the license service cannot be shut-down inadvertently from another machine on
the network with Imtools or the command-line utility Imdown.

Click the Start Server button [3]. The license manager should now be active.

Note: NEVER tick Force Server Shutdown - it can result in other License Services on the
network being shut down unintentionally. AVEVA products do not currently support
'‘Borrowed' licenses so there will never be any need to use this option.
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How to Check the License Service is Running

Using LMTOOLS:

Select the Server Status tab and click on Perform Status Enquiry.

LMTOOLS by Macrovision Corporation http://www.macrovision.com

File Edit Mode Help

SemvicesLicenze File] Suztem Settings] Utilities] Starta’Stnpx’HereadServerDiags Config Services] Bnlrnwingl

Helps to monitar the status of network, licenzing activities )
Options

Individual Daemon |

I Pretform Status Enguiy I Individual Featurs |

Server Mame |

———————— Y
Status
Flexible License Manager stetus on Tue 5/2/2008 13:54
[Detecting lmgrd processes...]
License server status: T44@UECAMD1GS4
License file(s) on UECAMD1&S54: C:AAVEVA\FlexMznd.l\license.lic:
W

|Using License File: C:AAWEWANFlextd and. Thlicensze lic

This shows what license features are now available from the License Server, by default for
all License Servers running on the network, the list can be narrowed by specifying an
individual server.

Note: Before re-running Perform Status Enquiry click on Edit>Clear Window to empty
the window of any previous enquiry results.

Using the Task Manager

Another way of confirming that the License Service is running is to use the Windows Task
Manager. Select the Processes tab and look to see that there is one cadcentre.exe
process and at least one Imgrd.exe process running. With some versions of FLEXnet, or if
running a product from another vendor that is also licensed with FLEXnet, it is possible to
see two or more Imgrd processes running, but this is normal.

Note: Tick Show Processes from all users in the Task Manager, to display correctly.
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2.9 Removing the Flexman 3.1 License Service

Note: If installing Flexman for the first time skip this section. However, if upgrading from
Flexman 3.1 this step is important.

Note: If the existing License Service has been redefined rather than creating a License
service with a new name, then do not perform this step.

When the Flexman 4.1 License Service is running correctly, you should remove the Flexman
3.1 Windows Service to prevent the computer from attempting to start both services at a
reboot.

Note: If the user prefers not to uninstall the Flexman 3.1 just yet, the user must disable the
Windows service using Control Panel> Administrative Tools > Services.

Use the LMTOOLS ConfigServices tab:

LMTOOLS by Macrovision Corporation hittp://www.macrovision.com

File Edit Mode Help

Service/License Filel Spstern Settings] Utililies] Start/Stop/Reread | Server Status ServerDiags Eorrowing]

Caonfigure Service

Save Service
=
Path ta the Imgrd.exe file |C: “Program FileshcadoentrehFlextan 3.7 4magrd. m

Fath ta the licenze file |C: “Program FileshcadoentrehFlestan 3.7 icens Blatse

Service Mame

Path ta the debug log file |C:\F'rogram FileshcadzentrehFlastan 3.14debu Browse | Wiew Log... |

v Start Server at Power Up ¥ Use Services

Make sure that the name of the Flexman 3.1 License Service is selected.
¢ Click on Remove Service.

e Un-install the Flexman 3.1 License Service using Control Panel > Add/Remove
Programs.

* When Flexman 3.1 is uninstalled, delete this folder manually:
C:\Program Files\cadcentre\Flexman 3.1.
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3 Updating a License File

Replacement License File

A license file be modified or renewed when requested, AVEVA will issue a new license file
containing the new entitlement together with any previous entitlement that has not yet
expired. The new license file is a complete replacement for the previous license.

Note: Nothing is achieved by cutting-and-pasting lines from an older license file.

Installing a Replacement License File in a Live Server

AVEVA suggests the following approach:

If it does not already exist, create a sub-folder named Old License Files, and move the
current license file down into it.

Copy the new license into the Flexman 4.1 folder

Rename the new licence file so that it has the same name as the old license file it is
replacing (e.g. license.lic).

Edit the license file header, if necessary, so that the Port Numbers match those in the
previous license file; there is no need to make any other changes to the license file.

Check that there is only one license file present in the folder - especially if a license file
has been edited and saved with a different name in-situ.

Restarting the License Service

Go to Control Panel > Administrative Tools > Services.
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File  Action View Help

¢~ B EFRE 2 »r i w

8 Services (Local)

Services (Local)

Updating a License File

CEX

FLEXNet License Service Mame | Description ] Status ] Startup Type J Log On As ]A
%Fast User Switching,.. Provides m... Manual Local System
j . FLEXMNet License Se... Automatic Local System
.% %Google Updater Ser... Manual Local System
%Help and Support Enables He... Started Automatic Local System
%H‘I‘I‘P S5L This servic... Manual Local System
%Human Interface D... Enables ge... Disabled Local System
%IMAPI CD-Burning C... Manages C... Manual Local System —
%Indexing Service Indexes co... Manual Local System
%IPSEC Services ManagesI... Started Automatic Local System
%Logical Disk Manager  Detects an... Started Automatic Local System
%Logical Disk Manage... Configures... Manual Local System
%Mad‘line Debug Man... Supportslo... Started Automatic Local System
%Mmfee Framework ... Sharedco...  Started Automatic Local System
%Mu\f&e McShield Provides M.., Started Automatic Local System
%Mc.ﬂ\fee Task Manager Allows sch... Started Automatic Local System
%Messenger Transmits ... Disabled Local System
M5 Snftware Shadn... Mananess... Mannal | nral Svstem ¥

\ Extended A Standard /

« Select the name of the Windows Service corresponding to your License Service.

¢ Click on Restart the Service

e Check the state of the license service using the Imtools utility or by inspecting the
debug.log file.

Note: This is the preferred approach to using Imtools, as it is quicker and should avoid
interrupting programs running during the update process. In particular be advised
against using the Imtools ReREAD facility, which only partially updates the license
service.
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4 Configuring a PC to Run AVEVA Products

4.1  FlexmanConfig Tool

FlexMan configuration tool for AVEYA application users
Help

[ How do I refer to my License Server? l [ Which setting should I use? l ’ Analyse and report settings ]

Vendor specific server settings (CADCEMTRE_LICENSE_FILE) - other vendors may not use all the settings below

Select Application Vendor IAVEVA (CADCENTRE) I You have Administrator rights to change System settings

User environment variable | | [ Set ]
System environment variable | | [ Set ]
System registry entry I 7152 @ukcamsls | I Set l [ Remove

Shared, all vendar server settings (LM_LICENSE_FILE) - any vendor specific server settings above will be tried before these

User environment variable | | [ Set ]
System environment variable | | [ Set ]
System registry entry | | [ Set ]

Configured Servers (double dick on a server to see full status information)

License Server Status
7152 @ukcamsls Active 4.x server

Undo all Changes [ Save and Exit ] [ Cancel

AVEVA products need to know where to find an active License Service running a license file
from AVEVA. FLEXnet tries to be helpful by searching through all the locations it knows
about. Unfortunately, there are rather too many possibilities and as a result the behaviour of
FLEXnet can seem unpredictable.

AVEVA recommends the use of our configuration tool FlexmanConfig to get a full picture of
the various settings involved and for making any required changes.

The simplest and most reliable approach is to set the vendor-specific Registry Entry, such
as CADCENTRE_LICENSE_FILE, and remove all other settings, as shown here:
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4.2

Configuring a PC to Run AVEVA Products

Note: Take care not to delete settings belonging to other vendors' software products also
licensed with FLEXnet that use the LM_LICENSE_FILE setting.

Click Set for each change made and the new settings will only take effect after Save
and Exit have been clicked.
AVEVA recommends using the Port@Host format to avoid problems with firewalls.

How an AVEVA Product Searches for a License

Note: The user can skip this section and use the FlexmanConfig tool by following the
instructions in FlexmanConfig Tool without having to understand this level of detail.

An AVEVA product that uses the cadcentre Vendor Daemon for its licensing will look for an
active License Service by searching these settings in this sequence:

1  Environment Variable: A USER Environment Variable setting overrides
CADCENTRE_LICENSE_FILE a SYSTEM Environment Variable setting

2  Reqgistry Entry:
CADCENTRE_LICENSE_FILE

3 Environment Variable: A USER Environment Variable setting overrides
LM_LICENSE_FILE a SYSTEM Environment Variable setting

4  Registry Entry:
LM_LICENSE_FILE

A blank USER Environment Variable setting has the effect of disabling a SYSTEM setting of
the same name.

Any one of these settings can be a list of three license servers separated by commas -This
is how a Three Redundant Server configuration is defined (see License Server List).

Usually, any one of these settings can be a list of license servers separated by semi-colons.
This is how a License Server List is defined. (See Running the License Service in a Virtual
Machine).

AVEVA Products built to run with Flexman 3.1 (effectively all product releases prior to the
end of 2008) have the following limitations that have since been resolved:

« Three Redundant Server provides resilience for only one server failure (see License
Server List).

e A License Server List will provide resilience if the first server in the list fails
completely. However, if the first server is active but all the licenses in use, any licenses
available on other servers in the list will be ignored.

*« Once an AVEVA product has successfully obtained a license it updates the Registry
Entry CADCENTRE_LICENSE_FILE.

« If an AVEVA product can not find an active License Server it will display a pop-up dialog
box requesting the location of a License Service. If successful, this would result in
setting the Registry Entry CADCENTRE_LICENSE_FILE.

* If you set the Environment Variable LM_LICENSE_FILE then run an AVEVA product it
will update Registry Entry CADCENTRE_LICENSE_FILE. Any subsequent changes to
that Environment Variable would then be ignored because of the search order
described above. This is why AVEVA recommends that you use the Registry Entry:
CADCENTRE_LICENSE_FILE.
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Resilience of the License Service

Servers are in general very reliable these days, but a hardware failure of the machine
running the License Service can be very disruptive to your business. A contingency plan is
advisable and some of the options are described in this section:

< Anchor the license file to a USB dongle that can be moved between servers
« Use athree-redundant server configuration for the License service

e Use a License Server List

« Use a virtual server, though AVEVA cannot endorse this approach.

Anchor the License File to a USB Dongle

AVEVA License files are normally anchored to the hardware ID of the machine on which the
License Service is installed: i.e. the Ethernet address of a network card resident in the
machine.

However, ask your AVEVA Account Manager for a USB Dongle and a License File that is
‘anchored' to the ID of the Dongle. If the server machine should fail, both the Dongle and the
current License File can be easily moved to another server and use them to start up new a
License service.

Download and install a Dongle Driver from the AVEVA Support site. It is a good idea to pre-
install a License Service and a Dongle Driver on the spare server, together with a copy of
the latest License File, to save time in the event of a hardware failure.

Setting up a 3 Redundant Server Configuration

FLEXnet supports a special configuration of three separate license server machines. The
three machines establish a quorum with one machine at time acting as the master that
serves the licenses. If the master (primary) machine fails, the secondary machine takes
over. The third machine never becomes the license server but is required to help maintain
the quorum should one of the other machines fail.

The following points must be noted before setting up such a configuration:

e« The three machines must have excellent communications as they need to
communicate with each other frequently. In practice this means they must all be on the
same LAN or a fast virtual LAN, but cannot be distributed across the world on a wide-
area network.

« To achieve a meaningful level of resilience the three servers and the networking
hardware must all be on an uninterruptible power supply.

* A special license file must be ordered that includes all three hardware IDs on three
SERVER lines in the license file. The customer must specify the hardware ID's in the
required sequence of Primary, Secondary, Tertiary.
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5.4

Resilience of the License Service

« A copy of the same license file must be installed on each of the three machines.
e The license service is started on each machine in the usual way.

* Do not use three virtual machines on the same physical machine for a three redundant
server configuration - the physical machine remains as a single point of failure.

¢ A machine on which an AVEVA product is running must be configured so that it is
aware of the locations of all three License Servers. When using FlexmanConfig tool,
the location of the License Server should be set to a list of server locations separated
by commas.

Note: There is a bug in the version of FLEXIm used in AVEVA products released before the
end of 2008 and that used Flexman 3.1. This bug limited the resilience of a three-
server configuration to surviving the first hardware failure: resilience was not re-
established without restarting all three of the License Services.

The solution for this problem is to set the location of the license services to a list of
license files separated by semi-colons, using the full pathname of the license files.
This requires mapped network drive letters. This is the only situation in which we
recommend the use of a license file path rather than the Port@Host format.

License Server List

It is possible to set the location of the License Service to a list of License Server locations
separated by semi-colons. If the first server in the list has failed then the next working
License Service in the list will be used. In this arrangement the customer's entitlement must
be split across the License Files on each License Server. (This is in contrast with a Three
Redundant Server configuration described above in which each server has an identical copy
of the same license file).

Running the License Service in a Virtual Machine

Virtual servers can be an attractive option for IT departments as a strategy for improving the
resilience of their servers. However, Acresso do not support the use of virtual machines with
the version of FLEXnet we are using, so AVEVA is unable to endorse this approach.

5:2



-AV=VA Flexman 4.1 Installation and Configuration Guide

6.1

6.2

6.3

6.4

Special Situations

Special Situations

Installing a License Service on Laptop

When AVEVA products are installed on a laptop or any other free-standing computer, it is
also necessary to install and configure a License Service. In this situation the laptop user
usually performs the role of License Administrator.

A laptop will typically have more than one Ethernet Address so take particular care when
ordering a License File and follow the instructions in How to Obtain a License from AVEVA
to select an Ethernet Address for a network adaptor that is always on and will never be
disabled.

It has never been possible with AVEVA license files to borrow an individual license from a
network license service for use on a laptop, so a separate license file must be ordered for
each laptop or free-standing computer.

Note: Some companies set up a pool of Dongles with matching license files so that a
license service can easily be set up on a laptop when it is required to go off-site.

Windows Vista

Note: Only authorised AVEVA product releases can be run on a Vista machine.

A machine running Vista Business or Vista Enterprise can be used for the Flexman 4.1
license service. Vista is much more protective of its Registry Settings so care is needed
when configuring a Vista PC to access the License Service.

Note: It is recommended that the user always uses the utility FlexmanConfig included as
the Client Install with Flexman 4.1 to be sure of correctly configuring access to a
License Service.

Locked-down PCs

Some companies operate a strict policy of 'locking-down' machines so that the user has
write access only to specified folders. It may not be possible in this situation for
FlexmanConfig to create Registry settings, in this case the User Environment Variable
setting must be used instead.

Other Products that use FLEXIm/FLEXnet Licensing

Other software suppliers also use FLEXnet licensing. Some AVEVA customers have in the
past reported problems after installing Flexman alongside AutoCAD. Take care when
configuring a PC to access the license server that no damage to the settings needed by the
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other supplier's software is made. Use FlexmanConfig and adjust the settings for the
cadcentre Vendor Daemon only. Take special care not to damage the Shared License
Settings needed by other products.

There is believed to be bug in the version of Imtools 10.5.0 distributed with AutoCAD. Before
reporting a problem to AVEVA, try using version 11.5 Imtools that is included in the Server
install of Flexman 4.1.

Note: When running products using FLEXnet licensing from different suppliers, it is
possible to see many Imgrd License Manager Daemons running, but this is normal.

AVEVA's Legacy Product M3

This guide does not cover installation or configuring of the license service for M3.

The M3 product also uses FLEXnet but does not use the cadcentre Vendor Daemon that is
used by the rest of our products. When using the M3 product suite the user will see the kcs
vendor Daemon running.

Note: The M3 product requires its own license file.

Citrix, Remote Desktop and Terminal Services

The license file received from AVEVA may not support running AVEVA products on a remote
machine via Citrix, Remote Desktop or Terminal Services. Contact the Account Manager if a
license file is required that will enable remote running of AVEVA products.

License Settings within Batch Files

If an environment variable in a batch file needs to be set, include a line something like this:
set CADCENTRE_LICENSE_FILE=744@ComputerName
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Troubleshooting

FLEXIm License Finder Dialog Box

When running AVEVA product releases designed to work with Flexman 3.1, the FLEXIm
License-Finder dialog box like this:

FLEXIm License Finder X

'our application wasz not able to obtain a licenze
becauge the FLEXIm license manager could not
determing where ta find the licensing data it
needs. Pleaze choose one of the folloving:

%) Specify the License Server
") Specify the License File

Copyright [] 1939, 2002 b acrovizion Corporation

This indicates that something has gone wrong either with the settings on the user's PC or
with the License Service itself.

Note: AVEVA recommends to Cancel this dialog box. The following error box will be
displayed and the exact wording will vary depending on the circumstances. Click OK
to dismiss the error box and follow the Troubleshooting hints below.
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Flexible License Manager @

Security Errar for PDMS: Cannok connect to license server

The server {Imgrd) has not been started wek, or

khe wrang park@hast or license file is being used, or the

pott or hostname in the license file has been changed.

Feature: CADCID

Server name:  ukmanl 16538

License path: 744@ukmanl 1653;

FLExIm error: -15,10. Swstem Error: 10061 "winSock: Connection refused”
Far Further information, refer to the FLEXIm End User Manual,

available at “www, globetrokter . com®,

Recommended approach:

* Run the Flexman Configuration tool FlexmanConfig and refer to the advice in Updating
a License File of this document.

* The License Administrator should check the status of the License Service and look for
any error messages in the debug.log file.

« If the fault cannot be identified locally, request help from AVEVA via e-mail. Include as
evidence: the current license file; the debug log-file; a screen shot showing any error
messages; and the analysis report from the Flexman Configuration tool.

Firewalls and Port Numbers

Here is the header of a typical AVEVA license file:

# ABC LG Feb 2007

# Customer Code ............... [UK-C1234]

# Customer Location Number .... [1]

# Issued On ... ... ... ... .. .... [24-Apr-2007] [11:44]
#

# All lines beginning with a # character are comments and can
be removed.

#

# This is a COMPLETE license file for this location

# Please replace the previous license_lic with this file
# and after renaming this File license.lic

#

#Server(s)

SERVER LGSERVO1 001422E5F0A7 744

#VENDOR Name

VENDOR cadcentre

As supplied, the line in the license file beginning SERVER ends with 744 (in older license
files it appears as TCP:744). This is the default port number for communicating with the
License Server process Imgrd.exe.
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With a SERVER line set as in the example license file shown, using FlexmanConfig set the
Vendor Specific Registry Entry to:

744@LGSERVO1

Because FLEXnet is used by so many software suppliers, port 744 is widely recognised as
the standard port for FLEXnet and is often reserved for this application. However, firewalls
are becoming increasingly diligent at shutting down ports and it may be necessary for this
port to be opened manually by a System Administrator before the license manager can
function.

The VENDOR line in the License File does not, as supplied, specify a port number.

To overcome problems with firewalls AVEVA recommends also adding a port number to the
VENDOR line in the license file. For example:

VENDOR cadcentre PORT=7123

The System Administrator must make sure the port numbers being used are open on the
License Server machine.

Note: AVEVA does not recommend the approach of setting the Environment variable to a
license file path as this is will result in problems with firewalls.

To edit the License File to add a port number to the VENDOR line use NOTEPAD. Do
not use WORD or WORDPAD which can result in invisible changes to the license file
that can prevent it from working.

Make sure that only one license file is in the Flexman 4.1 folder and that it has the
same name as any previous license file e.g. license.lic.

License Error -8

There are two circumstances likely to give this error:

1. Attempt to Install or Run an AVEVA Product via Remote Desktop or Citrix

The license file received from AVEVA may not support working via Citrix or Remote
Desktop using Terminal Services. License error -8 referring to the CADCID license
feature is characteristic of this problem.

Contact the account manager if experiencing this problem, the user may require a
license to enable remote running of AVEVA products.

2. CLOCKING the Machine on which the License Service is Running

Setting the system clock back is a trick sometime used to attempt to extend the life of a
license file. The License Service recognises that this has happened and refuses to
serve licenses.

AVEVA advice is that it is necessary to completely re-install the operating system to
clear this fault. Other than moving between time-zones, changing the system clock on
your machine is not recommended.

C:\flexIm Folder

The version of FLEXIm used in Flexman 3.1 created lock files in the folder C:\FLEXIm on the
license server machine.

After upgrading to Flexman 4.1 the C:\FLEXIm folder is no longer required because a
different mechanism is used. However, if you are running the Tribon M3 product at SP5 or
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Troubleshooting

earlier or any products based on FLEXIm licensing from other vendors, this folder may still
be used.

If the C:\flexIm folder is still needed, a problem can arise if access permissions to the C:
drive are too restrictive. The License Service can fail to start if files cannot be created in the
folder or this folder cannot be created in the first place.

License Server Filling-up with Licensing Daemons

This is a problem seen as a result of firewalls and permissions preventing the license server
from starting-up correctly.
When dealing with suspected firewall problems follow these guidelines:

« Make sure that port numbers are specified in the license file on both the SERVER and
VENDOR lines.

* Make sure both of the port numbers specified are open.

« In the FlexmanConfig tool, specify the Vendor Specific Registry Setting using the
Port@Host format.

Port Number Already in Use Error

If you see an error such as this in the debg.log file:
The TCP port number in the license, 744, is already in use.

it is possible to have started a new license service while the previous license service was
still running, or started it too quickly.

Look in the Task Manager, a possible symptom is to see three or four Imgrd processes
running but just one cadcentre process.

e Using LMTOOLS, select each License Service in turn and STOP the service.
« Start the new License Service again.

License Server List Not Working

This mechanism is designed for load-balancing the use of license seats over several
License Servers. If all the licenses on the first working License Server in use then the
intention is that the list will be searched in sequence for a working License Service with an
available license.

However, there was a bug in AVEVA products designed to run with Flexman 3.1 that
prevents this mechanism from working. These products always use the first working License
Service in the list. Other working License Servers in the list will be ignored even if they have
seats available. This problem has been resolved in Vista compatible AVEVA products.
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Structure of a License File

The name of the license file supplied by AVEVA is in the format:

LC031001-UK-C1073-12.dat

License / AVEVA \Server
Sequence Customer Sequence
Number Number Number

The License Sequence Number changes each time the license file is renewed or updated.

Header:

# BPM LG July 2007

# Customer Code ..ooovvvevnnens [UKCAMD1654]

# Customer Location Number ... [1]

# Issued ON covvveeveeeneeen, [18-Aug-2008] [14:41]

#

# All lines beginning with a # character are comments and can be removed.
#

# This is a COMPLETE license file for this location

# Please replace the previous license.lic with this file

# and after renaming this file license.lic

#

#Server(s)

SERVER UKCAMD1654 00110aa387d4 744 — Port Number can be changed
#VENDOR Name

VENDOR cadcentre PORT=7153 Port Number can be added

8:1



szVA Flexman 4.1 Installation and Configuration Guide
- Structure of a License File

Increment Lines:

Package Name WVersion

PACKAGE[PACK-VPD_PDMS|cadcentre |[1.00|6EBF2AF14BDB4321
COMPOMNENTS=|DESIGMN-PLATFORM ISODRAW PDMS|' user_info=UKCAMD1654 Y
ISSUED=18-aug-2008 \ Package Components
NOTICE="CREATED_BY=licencemanager,\,

UKCAMSMNAVISION, UKCAMSNavision_Licence_Generator,fx3.1,81a3 Y
CHKSUM=1I0UJDE" ck=121 SIGN2="1E7F 546E CoF4 SD5D S5B22 79FA Y\
SFO4 102D BC35 538A C332 ODF4 C7AS 89ES EES1 114D EQDAC SE98 1\,
SFD7 0SB4 129F 536E B486 B704 B728 23F7 5311 2739 AOQCT 24F0"

Increment Name Expiry Date
INCREMENT [PACK-VPD_PDMS|cadcentre 1.00[01-dec-2008|150]%
AGESBEEC3372EESB2 Mumber of Seats

WVENDOR_STRING=VO1FN240-Alan.Jenyon@aveva.com-Y
UKCAMD1654-TBL-NO-TSOK-UHD-Seat- Y

SUPERSEDE DUP_GROUP=UHD user_info=UKCAMD1654-1 %
ISSUER=aveva_group[I[SSUED=18-aug- 2008 |, Date License File was created
NOTICE="CREATED_BY =licencemanager, UKCAMSNAVISION,
UKCAMSMNavision_Licence_Generator,fx3.1,81a
CHESUM=1MN900K" ck=99 SN=1149828 \

[ETART =18-Aug-2008] License Increment can be used from this date
SIGN2="1187 54CA 76DB 6262 ED30 9ADD A675 AC9S SD62

E879 7C62 SC1B 7974 CE94 272A 124B 4FFF AE10 E250 DFD2 %,
6974 D6B2 D1BC F1FB 066C 061A 8623 SE7D 724B BCES"

A Package line does not define any entitlement on its own - it just gives a name to a
collection of component Features. The entitlement is defined in an Increment line which
follows.

The Increment line defines how many concurrent uses (seats) of a feature the customer is
entitled to use and when the entitlement will expire.

If the Increment refers to the name of a Package, the count applies to each of the
component features of the Package.
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